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Piksel: Ekranda kontrol edilebilen ve resimleri tanımlayabilen en küçük noktalara ki bu 

noktalar kare şeklindedir, bunlara piksel denir. Bir piksel kırmızı, yeşil ve mavi renklerin 

karışımından oluşur. Piksellerin sayısı ve renk derinliği resmin kalitesini belirler. Piksel tek 

başına bir ölçüyü ifade etmez. 

.  

 PIcture ELement den kısaltılmıştır. Resimlerin tanımlanmasında kullanılan temel 

birimdir. Piksel tabanlı resim programlarına Bitmap adı verilir. Dijital ortamda bulunan 

resimler milyonlarca pikselin bir araya gelmesiyle oluşurlar. Renk ve şiddet düzeyleri 

ayrıntıları ve sürekliliği belirler.  

 

Bit Derinliği: Görsel üzerindeki bir tek pikselin alabileceği renk sayısıdır. Bir piksele ait bit 

derinliği ne kadar fazla ise görüntü o kadar kaliteli hale gelir. 

1 bit derinlik varsa eğer 21=2 olacağından sadece siyah ve beyaz rengi söz konusudur. 

8 bit derinlik varsa eğer 28=256 farklı renk kullanılabilir. 

 

En çok kullanılan bit derinlikleri True Color (32bit), High Color (16bit), 256 Renk (8bit) 

  

DPI (Dot Per Inch): Bir inch diye tabir edilen 2,54 cm’lik alanda bulunan nokta sayısına 

denir. Görüntünün kaliteli olması gerektiği tasarımlarda veya görsellerde DPI’ın yüksek 

olmasına dikkat edilmelidir. Genel olarak kullanılan veya kullanılması gereken DPI değeri 

web tasarımında 72 iken basılı yayınlar için 300’dür. Düşük DPI’lı ve büyük basılacak işlerde  

bu duruma dikkat edilmezse görüntü pikseller görünür. 

 

PPI ve LPI : Açılımı Lines Per Inch olan LPI, 1 inch’teki çizgi sayısıdır. PPI ise 1 inch’teki 

piksel sayısı olup açılımı Pixel Per Inch’tir. 

 

Çözünürlük: Bir defada ekranda görüntülenebilen piksel sayısıdır. Örneğin; 800*600 

çözünürlüğündeki ekranda 480000 adet piksel bulunmaktadır.  

 

Anti-Aliasing: Oval kenarlara sahip bir görüntüye zoom yapıldığında kenarlarının tırtıklı 

bir şekilde olduğu görülecektir. Anti-aliasing ile kenarlara daha açık renkte pikseller 

eklenerek bu sorun giderilir. 

 

Enterpolasyon / Interpolation / Tahmin: Photoshop’ta bir resmi küçültmeye çalıştığınızda 

program piksel sayısını otomatik olarak azalttığı için sorun yaşamazsınız. Ancak bir resmi 

büyütmeye çalıştığınızda enterpolasyondan dolayı var olmayan pikseller görüntüye gireceği 

için sorun yaşayabilirsiniz. Çünkü program, büyütme işlemi sırasında pikselleri en yakın 

komşu renk tahmini ile oluşturur. Böyle bir sorun yaşamamak için resimleri 

boyutlandırırken piksel ayarlarını kontrollü bir şekilde ayarlamalı. 

Bir görselin boyutunu menülerden ImageImage Size yoluyla ayarlayabilirsiniz.  

 

RESİM FORMATLARI 

 Kodlama ve sıkıştırma algoritmalarına göre nitelendirilen ve en çok karşılaşılan resim 

formatları şunlardır. 

 

1. RAW: İngilizce’de ham, olmamış anlamında olan Raw, dosya uzantısı olarak işlenmemiş 

görsel veya ses dosyası anlamındadır. Dijital SLR fotoğraf makinelerinde çekilen fotoğraflar 
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bu formatta olduğu için düzenlenmesi daha kaliteli sonuçlar verir. Kayıplı sıkıştırma 

yapmaz ve ISO/ASA ile enstantane ve diyafram bilgileri içerir. 

 

2. BMP: En temel resim formatıdır. Windows işletim sistemi için Microsoft, PCX formatını 

geliştirerek oluşturmuştur. 16 ve daha fazla renk kaydedebilen ve herhangi bir sıkıştırma 

yapmayan, oldukça hızlı ve boyut olarak hafızada fazla yer kaplayan bir formattır. 

Windowsta Paint programının desteklediği dosya formatıdır.  

 

3. RAW: İngilizce’de ham, olmamış anlamında olan Raw, dosya uzantısı olarak işlenmemiş 

görsel veya ses dosyası anlamındadır. Dijital SLR fotoğraf makinelerinde çekilen fotoğraflar 

bu formatta olduğu için düzenlenmesi daha kaliteli sonuçlar verir. Kayıplı sıkıştırma 

yapmaz ve ISO/ASA ile enstantane ve diyafram bilgileri içerir. 

 

4. GIF (Graphics Interchange Format): Internet üzerinde yaygın olarak kullanılan bir format 

olup az sayıda renk içeren (1 ve 8 bitlik) dokümanlarda oldukça iyi sıkıştırma sağlar. Buda 

resmin hızlı görüntülenmesini doğrudan etki eder. Animasyonlarda zamanlama ve farklı 

boyutlardaki resimleri bir arada tutma desteği ile saydam renk tanımlaması ve farklı 

katmanlarda çalışabilmesi gibi üstünlükleri vardır. LZW isimli sıkıştırma algoritması 

kullanmaktadır.  

 

5. PDF (Portable Document File): Adobe firmasının geliştirdiği bu dosya uzantısı Taşınabilir 

Dosya Uzantısı anlamındadır. Acrobat programı ile düzenlenip Adobe Reader programı ile 

kolaylıkla açılabilir. Photoshop’ta  yapılan tasarımlar baskıya gönderilirken genellikle bu 

formatta gönderilir. 

 

6. EPS (Encapsulated Postscript): Vektör ve piksel tabanlı görüntüler için kullanılan 

formattır. Çoğunlukla matbaacılar tarafından kullanılır. QuarkXpress, Adobe Photoshop, 

Illustrator, Corel Draw vb. programlarda kullanılırlar. 

 

7. JPEG (=JPG (The Joint Photographic Experts Group)): Gerçek renk değerini içeren bir 

sıkıştırma formatıdır. Görüntünün algılanması için çok gerekli olmayan detayları atarak 

sıkıştırma yapılmasından dolayı kayıplı formatlar arasında yer alır. Kaybedilen detaylar 

hiçbir şekilde getirilemez. 256 ve daha fazla renk kullanan resimler için idealdir. Dolayısıyla 

daha az renk içeren uygulamalarda kaliteyi düşürür ve boyutunda değişme gerçekleştirmez. 

24 bit True Color uygulamalarda resim kalitesinde gözle görülür kayıplar meydana 

gelmektedir. Megabyte olan resim boyutlarını duruma göre rahatlıkla kilobyte seviyelerine 

düşürür. 

 

8. PSD: Photoshop uygulamalarına özel bir formattır. Çok sayıda alfa kanalı, path ve layer,’ı 

destekleyerek, ikili dosya, indekslenmiş renk, RGB, CMYK, LAB biçimlerinde çalışmaya 

olanak sağlar. Çalışmaya yönelik kullanılır, dosya transferine pek olanak sağlamaz. 

 

9. TIFF (Tagged Image File Format): Farklı işletim sistemleri ve uygulamalar arasında 

kayıpsız ve esnek bir dosya yapısı sağlayan çalışmalar için kullanılan formattır. Bu format, 

RGB, CMYK, LAB gibi tüm renk birimlerini destekler. Pek çok sıkıştırma algoritmasıyla 

birlikte sık olarak LZW sıkıştırma algoritmasını da kullanmaktadır. Bu formatı kullanan 

resimler, herhangi bir uygulama ortamına alındıklarında, görüntünün ve zeminin renk 
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değerlerini azaltma ve değiştirme olanağına izin verirler. Çok sayıda alfa kanalı 

desteklemektedir. JPG’e göre hafızada daha fazla yer kaplamaktadır. 

 

10. PNG (Portable Network Graphics): 48 bitlik True Color desteği olan formattır. Kayıpsız 

Wave Table sıkıştırma yöntemini kullanır. Şu anda mevcut olmayan kayıpsız gerçek renk ve 

saydamlık bilgilerini içeren resim kalitesini internete taşımayı amaçlar. Bu saydamlık 

bilgileri alfa kanalında saklanmaktadır.  

 

 Yukarıda anlatılan uzantılar dışında PSB, DCM, DIC, PCX, PXR, TGA gibi resim 

formatları da vardır.  
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Photoshop'u başlattığınızda, Araçlar paneli varsayılan olarak ekranın sol tarafında gösterilir.  

İmleci araç üzerine getirerek araç hakkında bilgi görüntüleyebilirsiniz. Aracın adı, imlecin 

altında bir araç ipucunda gösterilir. 
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Gizli Araçlar Hakkında Not:  

 Araçların sağ alt köşelerinde bulunan küçük ok işareti o aracın altında 

gizlenen başka araçların olduğunu gösterir. Bu gizli araçları görmek için ; 

1- Mouse ile aracı bir defa tıkladıktan sonra  bir süre bekleyebilir ya da 

aracın üzerinde mouse ile sağ tıklayabilirsiniz. 

2- Shift tuşunu basılı tutup araç kısayol tuşuna tekrar tekrar basarak gizli 

araçların olduğu bir grupta gezebilirsiniz. 

3- Shift tuşuyla araç değiştirme özelliğini kapatıp açmak için Düzen> Tercihler> Genel 

yolunu seçebilirsiniz. 
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A) SEÇİM ARAÇLARI 

Rectangular Marquee Tool (Dikdörtgen seçim aracı) : Kare 

veya dikdörtgen şeklinde seçim yapmaya yarar. Yapılan 

seçimin içi doldurularak kare, dikdörtgen oluşturulabilir. 

Elliptical Marquee Tool (Daire Seçim Aracı): Elips veya 

daire şeklinde seçim yapmaya yarar. Yapılan seçimin içi doldurularak elips, daire 

oluşturulabilir. 

Single Row Marquee Tool (Tek Satır Seçim Aracı): Yatay yönde tek piksellik seçim 

gerçekleştirir.  

Single Column Marquee Tool (Tek Sütun Seçim Aracı): Dikey  yönde tek piksellik seçim 

gerçekleştirir.  

Move Tool (Taşıma Aracı): Seçilen bir alanı veya Layer/Katman’ı taşır.  

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Lasso Tool (Kement Aracı):  Kalemle çizim yapar gibi seçim 

yapmaya yarar. Alt tuşuna basarak seçili  alanın içinden istenilen 

kısmı çıkarabildiğiniz gibi, Shift tuşuna basarak da seçime yeni 

bir kısım daha eklenebilir. 

Polygonal Lasso Tool (Çokgen Kement Aracı): Özellikle köşeli yapılarda düz hatlar şeklinde 

seçimler yapmaya yarar. 

Magnetic Lasso Tool (Mıknatıslı Kement Aracı): Kontrast ve ton değerleri ile seçimler yapar. 

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Quick Selection Tool (Hızlı Seçim Aracı): Brush/Fırça aracındaki gibi boyama yapar şekilde 

hızlı seçim yapmaya yarar. 

Magic Wand Tool (Sihirli Değnek Aracı): Görsel üzerindeki 

benzer renk piksellerini tespit ederek ona göre seçim yapar. Bu aracı kontrol paneldeki 

tolerans default değeri 32’dir, 1-100 arası değer vererek istenen hassasiyeti ayarlayabilirsiniz. 

 

B) KIRPMA VE DİLİMLEME ARAÇLARI 

Crop Tool (Kırma Aracı): Görsel üzerindeki fazla kısımları kesip atmaya yarar. 

Perspective Crop Tool (Perspektif Kırpma Aracı): Croop tool’da 

olduğu gibi kırpma yapar ve kırpma sonucuna perpektif etkisi verir. 
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Slice Tool (Dilimleme Aracı): Photoshop’ta yapılan web sayfası tasarımını parçalara 

ayırmaya yarar. Sitenin hızı açısından önemli bir işlemdir. 

Slice Select Tool (Dilim Seçim aracı): Slice Tool ile bölünen görsel parçalarının seçerek 

düzenlenmesini sağlar. 

C) ÖLÇÜM ARAÇLARI 

Eyedropper Tool (Damlalık Aracı): Bu araç ile çalışma sayfamızdaki 

beğendiğimiz, kullanmayı istediğimiz rengi görsel üzerinden 

seçmeye yarar. 

Color Sampler Tool (Renk Örnekleme Aracı): 4 ayrı renk üzerinde 

çalışma yapabilmeyi sağlar. 

Ruler Tool (Cetvel Aracı): Görsel üzerinde iki nokta arasındaki mesafeyi ölçer. 

Notes Tool (Not Aracı): Görsel üzerinde hatırlatıcı notlar bırakmayı sağlar. 

Count Tool (Sayma Aracı): Görsel üzerindeki istenen yerlerde rakamlar kullanarak 

işaretleme yapar. 

D) RÖTUŞ ARAÇLARI 

Spot Healing Brush Tool (Nokta Düzeltme Fırçası): Genellikle 

sivilce, yara, ben benzeri lekeleri temizlemek için kullanılan bir 

doku onarma aracıdır.  

Healing Brush (Düzeltme Fırçası): Belirli bir alandaki dokuyu 

alır ve bozuk doku üzerine yumuşatarak yerleştirerek onarma yapar. 

Patch Tool (Yama Aracı): Görsel üzerindeki bozuk olan dokunun yama yöntemiyle 

onarılmasını sağlar. 

Red Eye Tool (Kırmızı Göz Aracı): Fotoğraflardaki kırmızı göz sorununun giderilmesini 

sağlar. 

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Clone Stamp Tool (Klonlama Aracı): Belirlediğimiz bir alandaki 

dokunun istenen başka bir yere klonlanmasını sağlar. Rötuşlamada 

çok kullanılan bu araç görseldeki bozuk kısımların düzeltilmesinde 

oldukça başarılıdır. 

Pattern Stamp Tool (Desen Damgası Aracı): Oluşturulan dokunun istenen alana hızlı bir 

şekilde uygulanmasını sağlar. 
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Eraser Tool (Silgi Aracı): Görselde istenen yerleri silmeye yarar. Opacity/şeffaflık değeri 

ayarlanarak mükemmel sonuçlar elde edilebilir. 

Background Eraser Tool (Arkaplan Silgi Aracı): Genellikle iki 

farklı rengi birbirinden ayırmak için kullanılan bu araç görselin 

karışık olan arka planını silmeye yarar. 

Magic Eraser Tool (Sihirli Silgi Aracı): Magic Wand aracındaki olduğu gibi çalışır, aynı renk 

piksellerine sahip bölgeleri hızlı bir şekilde silmeyi sağlar. 

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Blur Tool (Bulanıklık Aracı): Görseldeki istenen yerleri  yumuşatarak flu bir görünüm verir.  

Örneğin portre resimlerindeki cilt bozuklukları bu araç yardımıyla iyileştirilebilir. 

Sharpen Tool (Keskinleştirme Aracı): Blur’un tam tersi çalışır, pikselleri 

keskinleştirir. 

Smudge Tool (Bulaştırma Aracı): Renkleri birbirine karıştırarak 

bozukluk gidermeyi sağlar. 

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Dodge Tool (Soldurma Aracı): Görseldeki gölgeleri veya karanlık bölgeleri aydınlatır ya da 

patlama yapan renkleri soldurur. 

Burn Tool (Yakma Aracı): Görsel üzerindeki renkleri derece derece 

yakarak koyulaştırır. Dodge Tool’un tam tersi mantıkla çalışır. 

Sponge Tool (Sünger Aracı):  2 modda çalışan bir araçtır. İsterseniz 

renklere doygunluk verir, isterseniz renklere matlık verirsiniz. 

E) BOYAMA ARAÇLARI 

Gradient Tool (Renk Geçiş Aracı): Belirlenen iki renk arasında geçiş 

yaparak boyama yapar. 

Paint Bucket Tool (Boya Kovası Aracı): Seçilen alanın istenen renge boyanmasını sağlar. 

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Brush Tool (Fırça Aracı): Bildiğimiz anlamda fırça kullanıyor 

gibi istenen alanın boyanmasını sağlar. 

Pencil Tool (Kalem Aracı): Kalemle çizim yapar gibi çizim 

yapmaya yarar, kalem ucu 1 pikseldir. 
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Color Replacement Tool (Renk Değiştirme Aracı): Görselde yer alan bir nesnenin rengini 

paletten seçilen bir renk ile değiştirmeye yarar. 

Mixer Brush (Karıştırma Aracı): Görsel üzerindeki renkleri karıştırmaya yarar.  

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

History Brush Tool (Geçmiş Fırçası Aracı): Görsele uygulanmış 

efekt, filtre veya herhangi bir işlemi geri geri almak için kullanılır. 

Opacity değerleri ayarlanarak etkileyici sonuçlar elde edilebilir.  

Not: Window menüsünden History paneli açılarak istenilen noktayı seçerek yaptığımız 

işlemleri rahatlıkla geri alabiliriz. 

Art History Brush Tool (Sanat Fırçası Aracı): Üzerinde çalıştığımız görseli görsel olmaktan 

çıkarıp suluboya ile boyanmış gibi artistik/sanatsal bir resim haline getirir. 

F) ÇİZME VE YAZMA ARAÇLARI 

Pen Tool (Kalem Aracı): Profesyonel bir seçim aracıdır. Seçim 

yapılacak noktaları ve seçimin dönüş açılarını kendiniz 

belirleyerek vektörel bir seçim yapmaya yarar. Paths paneli ile 

birlikte kullanılır. 

FreeForm Pen Tool (Serbest Form Kalem Aracı): Mouse kullanılarak yapılan serbest 

hareketler ile path/yol çizmek için kullanılır. 

Add Anchor Point Tool (Path Noktası Ekleme Aracı): Bir path’in parça sayısını artırmak için 

yola yeni noktalar eklemek için kullanılır. 

Delete Anchor Point Tool (Path Noktası Çıkarma Aracı): Bir path’in parça sayısını azaltmak 

için yol üzerindeki noktalar silinir. 

Convert Point Tool (Nokta Dönüştürme Aracı): Vektör çizimin path yolu üzerindeki bir 

geçisin keskinliğini bu araçla yumuşatabilirsiniz.  

***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   ***   *** 

Rectangular Tool  (Dörtgen Çizim Aracı): Vektör dikdörten veya kare çizmeye yarar. 

Rounded  Rectangular Tool (Köşeleri Yumuşatılmış Dörtgen 

Çizim Aracı): Köşeri yumuşatılmış dikdörtgen veya kare 

çizmeye yarar. 

Elipse Tool (Elips Çizme Aracı):  Elips veya daire çizmeye yarar. 

Polygon Tool (Çokgen Çizme Aracı): Vektör çokgen (altıgen, 
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beşgen vb) çizmeye yarar. 

Line Tool (Çizgi Aracı): İstenilen kalınlıkta düz çizgi çizmeyi sağlar. 

Custom Shape Tool (Hazır Şekil Aracı): Hazır şekiller listesinden isteneni çizmeyi sağlar. 
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DERS 2- Temel Özellikler 

Bu bölümde Photoshop’un dört temel özelliğini (Layer Sistemi, Seçili Alan Oluşturma, Doku 
Kopyalama ve Maskeleme) işlemlerini ana hatlarıyla anlatacağım. 

a. Layer (Katman) Sistemi 

Görselde yer alan dondurma topları yan yana durduğu için tek bir imaj gibi görünüyor olabilir 
ama burada üç ayrı katman var yani bu topların her biri ayrı bir layer. Bir topu diğerinin 
üzerine taşıdığımda üstteki layer alttaki layer’ın bir bölümünü kapatmış oluyor. Layer’ların 
yerlerini Layers Panelinden istediğim gibi değiştirebiliyorum. Ortadaki layer’ın opacity yani 
şeffaflık değerini azalttığımda ise alttaki layer’ın gizli kalan kısmı görünmeye başlıyor. Layer 
mantığı için bu ön bilgi yeterli olacaktır. 

b. Seçili Alan Oluşturma 

Genellikle çalışmada bölgesel bir değişiklik yapmak istediğinde ilk önce seçili alan oluşturman 
gerekir. Seçim işlemini yapabileceğin bir çok araç mevcut. Biz şimdi elips seçim aracı ile bir 
seçim gerçekleştirelim ve seçtiğimiz alanı silelim. Gördüğün gibi silme işlemi sadece seçtiğim 
alanda, dışarı taşmadan gerçekleşti. Başka işlemlere devam etmek için bu seçimi kaldırman 
gerekiyor. Bunu Select>Deselect seçeneği ile veya Komut+D kısayolu ile yapabilirsin. 

c. Doku Kopyalama 

Dondurma toplarının üzerinde oluşmuş çatlakları doku kopyalama yoluyla yok etmek için en 
temel Photoshop araçlarından biri olan Clone Stamp Tool’u seçiyorum. Alt’a basarak 
kopyalamak istediğim dokuya tıklıyorum, sonra düzeltmek istediğim yere tıklayıp dokuyu 
buraya kopyalıyorum. Yıllar içinde Photoshop bu işlemi farklı metotlarla yapan birçok araç 
geliştirdi. Bu araçların hepsini Toolbar dersinde anlatacağım. 

d. Maskeleme 

Maskeleme, sonradan değişiklik yapma ihtimali olan işlemler için kullanılır. Mesela 
dondurmanın bir bölümünü silmek için bu layer’a bir maske oluşturuyorum ve maskenin 
seçili olduğundan emin oluyorum. Ardından Brush Tool ile istediğim alanı siyaha boyuyorum 
(gizliyorum). Diyelim ki, ilerleyen aşamada gizlediğim alanın bir kısmını geri getirmek 
istiyorum. Bunun için beyaz rengi öne getirip Brush Tool ile istediğim alanı boyuyorum ve 
gizleme işlemini geri almış oluyorum. En temel maskeleme yöntemi budur. Bunun dışındaki 
farklı maskeleme yöntemlerini sonraki derslerde anlatacağım. 

DERS 3- Toolbar (Araçlar) 

Bu bölümde Photoshop’taki Toolbar (araçlar) bölümünü mümkün olduğu kadar kısa ve öz 
olarak anlatmaya çalışacağım. Tüm araçlara kolay ulaşabilmen için bu konuyu tek derste 
toplamak istiyorum. 



a. Hareket ve Seçim Araçları 

 

Move Tool (Taşıma Aracı), genellikle layer’ları taşımanı sağlar. Auto select özelliğiyle layerları 
otomatik olarak seçebilirsin. 

 

Artboard Tool (Çalışma Sayfası Aracı) ise web veya mobil tasarımlar yapmak için çoklu 
sayfalar oluşturmanı sağlayacak bir araçtır. Tasarımını yapacağın ekran boyutunu seçip, 
birden fazla sayfa oluşturabilirsin. 

 

Rectangular Marquee Tool (Dikdörtgen İşaretleme Aracı) kare veya dikdörtgen seçimler 
oluşturmanı sağlar. Shift’e basarak kullandığında kare seçim yapabilirsin. 

 

Elliptical Marquee Tool (Oval İşaretleme Aracı) ile oval seçimler yapabilir, shift’e basarak 
yuvarlak seçimler oluşturabilirsin. 

 

Single Row Marquee Tool (Tek Satır İşaretleme Aracı), 1 piksellik yatay seçimler yapar.  

 

Single Column Marquee Tool (Tek Sütun İşaretleme Aracı), 1 piksellik dikey seçimler yapar.  

 

Lasso Tool (Kement Aracı) serbest el çizimi ile seçimler yapmanı sağlar. 

 

Polygonal Lasso Tool (Çokgen Kement Aracı) ile istediğin yerleri tıklayarak daha güvenli 
seçimler yapabilirsin. Noktaları silmek için Backspace’i kullanabilirsin. 

 

Magnetic Lasso Tool (Manyetik Kement Aracı) ile de renk farkının çok keskin olduğu yerlerde 
sadece mouse hareketiyle otomatik seçimler yapabilirsin. 

 



Quick Selection Tool (Hızlı Seçim Aracı) bir bölgede mouse hareketiyle bölgesel seçimler 
yapmanı sağlar. Birbirine yakın renk tonlarının olduğu alanlarda kullanımı daha uygundur. 

 

Magic Wand Tool (Sihirli Değnek) Seçmek istediğin bölgeye tıklayarak buradaki en yakın renk 
tonlarını seçebilirsin. Hassasiyet değerini ayarlayabilir, shift veya alt tuşunu kullanarak 
mevcut seçime yeni seçimler ekleyebilir veya çıkarabilirsin. 

b. Kırpma ve Dilimleme Araçları 

 

Crop Tool (Kırpma Aracı) fotoğrafa kadraj yapmanı yani, yeni bir bakış açısıyla yorumlamanı 
sağlar. İstediğin alanı çerçeve içine alır ve enter tuşuyla bu yeni görünümü aktif hale 
getirebilirsin. 

 

Perspective Crop Tool, fotoğrafta eğik şekilde duran dikey ve yatay doğruların otomatik 
olarak düzeltilmesini sağlar. 

 

Slice Tool (Dilimleme Aracı), genellikle web sayfası tasarımlarında çalışma alanını dilimlere 
bölerek, bu dilimlerin ayrı ayrı işlenebilmesini ve kaydedilebilmesini sağlar. 

 

Slice Select Tool (Dilim Seçme Aracı) ise oluşturduğun tüm dilim gruplarını seçebilmeni 
sağlar. 

 

Frame Tool (Çerçeve Aracı) ile fotoğrafların içine gömülü olduğu elips veya köşeli çerçeveler 
oluşturabilirsin. 

c. Tespit ve Ölçüm Araçları 

 

Eyedropper Tool (Damlalık Aracı), çalışmada yer alan bir rengi palete aktarmanı sağlayan bir 
araçtır. Aktarmak istediğin renge tıklaman yeterli olacaktır. 

 



3D Material Eyedropper Tool (3 Boyutlu Damlalık Aracı) 3 boyutlu çalışmalardaki renkleri 
palete aktarmanı sağlar. 

 

Color Sampler Tool (Renk Örnekleme Aracı) ile bir bölgedeki renk değerlerini görebilirsin. Bu 
sayede fotoğrafta doğru ışık ve renk ayarları yapabilirsin. 

 

Ruler Tool (Cetvel Aracı) çalışmada iki nokta arasındaki uzaklığı ölçmeni sağlar. Yukarıda bu 
değerleri görebilirsin. 

 

Note Tool (Not Aracı), istediğin yerlere hatırlatıcı notlar bırakmanı sağlar. 

 

Count Tool (Sayma Aracı) çalışmada yer alan aynı türdeki nesneleri belirleyip, bu 
nesnelerden kaçar tane ve nerelerde olduğunu göstermeni sağlayan bir araçtır. 

Pratik Bilgi: Tüm araçların kısayollarını aracın üstüne geldiğinde parantez içinde görebilirsin 
ve kısayol harfini shift ile kullandığında çoklu araç seçenekleri arasında geçiş yapabilirsin. 

d. Rötuş ve Boyama Araçları 

 

Spot Healing Brush Tool (Nokta Düzeltme Fırçası) ile kaybolmasını istediğin bir bölgeyi 
işaretler ve o bölgenin, çevresindeki en yakın doku ile değişmesini sağlarsın. 

 

Healing Brush Tool (Düzeltme Fırçası) ile sorunlu bölgenin yakınındaki bir dokuyu alt tuşuyla 
kopyalar ve sorunlu bölgeye taşırsın. Yeni doku aynı zamanda sorunlu bölgenin tonlarıyla 
uyum sağlayarak gelir. 

 

Patch Tool (Yama Aracı) ile işaretlediğin bölgeyi, belirlediğin uygun bir alana sürükleyerek 
buranın dokusuyla değiştirmiş olursun. Yeni doku yine sorunlu bölgenin tonlarına uygun 
olarak gelir. 

 



Content-Aware Move Tool (İçeriğe Uygun Taşıma Aracı) ise işaretlediğin bölgeyi, başka bir 
bölgeye taşımana yarar. Boş kalan bölgeyi de uygun dokuyla tamamlar.  

 

Red Eye Tool (Kırmızı Göz Aracı) ile flaşlı çekimlerde gözlerde oluşan kırmızı rengi ortadan 
kaldırabilirsin. İşaretlediğin bölgedeki kırmızıya en yakın tonları soldurur ve koyulaştırır. 

 

Brush Tool (Fırça Aracı), çizim ve boya işlemleri yapmaya yarar. Kendine özel fırçalar da 
oluşturabilirsin. Bu konuyu Pratik Bilgiler dersinde anlatacağım. 

 

Pencil Tool (Kurşun Kalem Aracı), fırçaya oranla daha keskin kenarlı çizimler yapmanı sağlar. 

 

Color Replacement Tool (Renk Değiştirme Aracı), bir nesneyi tonlarını değiştirmeden seçtiğin 
bir renkle boyamanı sağlar. 

 

Mixer Brush Tool (Karıştırıcı Fırça) ile çalışmadaki renklerden karışım oluşturabilir, ayrıca 
herhangi bir dokuyu alt tuşu ile palete ekleyerek bu doku ile farklı efektlerde boyamalar 
yapabilirsin. Boş vaktinde detaylı olarak incelemeni tavsiye ederim. 

 

Clone Stamp Tool (Klonlama Damga Aracı), rötuş çalışmalarında etkin olarak kullanılan bir 
araçtır. Alt tuşuna basılı tutup bir dokuyu kopyalar ve düzeltmek istediğin yere tıklayarak 
dokuyu buraya kopyalarsın. 

 

Pattern Stamp Tool (Desen Damga Aracı) ile desen boyamaları yapabilirsin. Kendine özgü 
desenler oluşturmayı Pratik Bilgiler dersinde anlatacağım. 

 

History Brush Tool (Geçmişe Dönme Fırçası), ile yaptığın değişiklikleri sonradan geri alabilir 
veya etkisini azaltabilirsin. (Boyut değişikliği yapmamak kaydıyla) 

 

Art History Brush Tool (Resim Geçmişe Dönme Fırçası) ile fotoğrafın orijinal haline kısmen 
sadık kalarak farklı sanatsal efektler deneyebilirsin.  



 

Eraser Tool (Silgi Aracı), silme işlemlerini yapacağın araçtır. Sildiğin şeyleri geri alabilme 
imkanı da sunar 

 

Background Eraser Tool (Arka Plan Silgi Aracı) ile arka planın herhangi bir bölgesini 
silebilirsin. 

 

Magic Eraser Tool (Sihirli Silgi Aracı)’nı Magic Wand gibi düşünebilirsin. Bu araçla, belirlediğin 
hassasiyet değeri doğrultusunda, dokunduğun alandaki birbirine yakın renk tonlarını 
doğrudan silebilirsin. 

 

Gradient Tool (Degrade Aracı) ile iki veya daha fazla renk arasında yumuşak geçişler 
oluşturabilirsin. 

 

Paint Bucket Tool (Boya Kovası Aracı), birbirine yakın renk tonlarını tek dokunuşla farklı bir 
renkle boyamanı sağlar. 

 

3D Material Drop Tool (3 Boyutlu Boyama Aracı) ile 3 boyutlu nesneleri renklendirebilirsin. 

 

Blur Tool (Bulanıklaştırma Aracı) ile dokunduğun bölgeleri bulanıklaştırabilirsin. 

 

Sharpen Tool (Keskinleştirme Aracı) ise istediğin bölgelere netlik vermeni sağlar. 

 

Smudge Tool (Leke Aracı) ile dokuları çekerek uzatabilirsin. 

 

Dodge Tool (Soldurma Aracı) dokunarak aydınlatma işlemi yapar. 

 



Burn Tool (Yakma Aracı) ise koyulaştırma yapar. 

 

Sponge Tool (Sünger Aracı) ise renkleri soluklaştırmaya (Desaturate) veya tam tersi 
doygunluğunu artırmaya yarar (Saturate).  

e. Çizim ve Yazı Araçları 

 

Pen Tool (Kalem Aracı) genellikle detaylı seçim işlemlerinde kullanılır. Pen Tool ile 
oluşturulan seçim çizgisine “path” (yol) denir. 

 

Freeform Pen Tool (Serbest Biçim Kalem Aracı) ile serbest el çizimleriyle path 
oluşturabilirsin. Manyetik özelliği ise, renk ayrımı olan yerlerde otomatik seçim yapar. 

 

Curvature Pen Tool (Kavisli Kalem Aracı) ile path oluştururken sistematik kavisler elde 
edebilirsin. 

 

Add Anchor Point Tool (Bağlantı Noktası Ekleme Aracı) ile oluşturduğun “path”e ihtiyaç 
doğrultusunda fazladan noktalar ekleyebilirsin. 

 

Delete Anchor Point Tool (Bağlantı Noktası Silme Aracı) ise “path” içinde fazla olduğunu 
düşündüğün noktaları çıkarmanı sağlar. 

 

Convert Point Tool (Noktayı Dönüştürme Aracı) ile path’deki köşe noktalarını kavisli hale 
getirebilirsin. 

 

Horizontal Type Tool (Yatay Yazım Aracı) ile çalışmana yazılar yazabilirsin. 

 

Vertical Type Tool (Dikey Yazım Aracı) ise yukarıdan aşağıya yazı yazmanı sağlar. 

 



Vertical Type Mask Tool (Dikey Yazım Maskesi), dikey olarak yazdığın yazıyı maske olarak 
veya sadece seçili alan olarak kullanmana imkan tanır. 

 

Horizontal Type Mask Tool (Yatay Yazım Maskesi) ise aynı özelliği yatay yazılar için 
kullanmanı sağlar. 

Pratik Bilgi: Type Mask işlemini var olan yazı layer’ına Komut ile tıklayarak da yapabilirsin. 

 

Path Selection Tool (Yol Seçim Aracı) ile oluştuduğun path’i bir bütün olarak kolayca 
seçebilirsin. 

 

Direct Selection Tool (Doğrudan Seçim Aracı) ile path üzerindeki bir noktayı veya bir çizgiyi 
seçip değişiklik yapabilirsin. 

 

Rectangle Tool (Dikdörtgen Aracı) ile path mantığında kare veya dikdörtgen şekiller 
oluşturabilirsin. 

 

Rounded Rectangle Tool (Yuvarlak Köşeli Dikdörtgen) ise köşeleri yuvarlak kare veya 
dikdörtgen oluşturmanı sağlar. 

 

Ellipse Tool (Elips Aracı) ile oval şekiller veya daireler oluşturabilirsin. 

 

Polygon Tool (Çokgen Aracı) ile de çokgen veya yıldız şekli yapabilirsin. 

 

Line Tool (Çizgi Aracı) ile dilediğin kalınlıkta çizgisel path’ler ve yönlendirme okları 
oluşturabilirsin. 

 

Custom Shape Tool (Özel Şekil Aracı) ile ister kütüphanede yer alan şekillerden, istersen yeni 
yükleyeceğin şekillerden path’ler oluşturabilirsin. Kendine özel şekiller oluşturmayı ise Pratik 
Bilgiler dersinde anlatacağım. 



f. Yardımcı Araçlar 

 

Hand Tool (El Aracı), büyük görüntülerde Space tuşuna basarak ekranı fareyle kaydırıp, 
detaylı olarak incelemene yardımcı olur. 

 

Rotate View Tool (Görünümü Döndürme Aracı) ile çalışma dosyanı döndürebilir ve çalışmana 
farklı açılardan bakabilirsin. 

 

Zoom Tool (Yakınlaştırma Aracı) ile dilersen çalışmanı kademe kademe büyütüp küçültebilir 
veya bölgesel olarak yakınlaştırma yapabilirsin. 

 

Edit Toolbar (Araç Çubuğunu Düzenle) ile ihtiyacın olan veya en çok kullandığın araçları 
toolbar’a ekleyip, kendine özel bir düzen oluşturabilirsin. 

 

Color Picker (Renk Seçici) bölümünde Foreground Color (ön plan rengi) ve Background Color 
(arka plan rengi) olmak üzere iki renk paleti yer almaktadır. Bu kutucuklara tıklayarak 
istediğin rengi seçebilir, “X” tuşu ile yerlerini değiştirebilir veya “D” ile varsayılana 
dönebilirsin. 

 

Quick Mask (Hızlı Maske), Brush Tool ile seçili bir alan oluşturmanı sağlar. Oluşturduğun 
seçili alanın kenar yumuşaklığı, fırçanın kenar yumuşaklığıyla aynı değerde olacaktır ki bu, 
hayati önem taşıyan bir özelliktir. 

 

Screen Mode (Ekran Görünümü) ise bize üç farklı ekran tipi sunuyor. “F” tuşu ile bunlar 
arasında geçiş yapabilirsin. 

Tebrik ederim, en uzun dersi bitirdin. Bir kahveyle kendini şımartmalısın. 

DERS 4- Panel Kullanımı (Layers Paneli) 

Bu bölümde Photoshop’ta en çok kullanılan Layers Panelini tanıtarak, panel kullanımına 
ilişkin genel bir fikir edinmeni sağlayacağım. 



Öncelikle tüm panelleri Window menüsünden açıp, kapatabilirsin. Sık kullanılan panellerin 
kenarında kısa yolları da yazıyor. En çok kullanacağın panelleri açarak kendine özgü bir 
çalışma alanı oluşturabilir veya ekranın sağ üst köşesinde yer alan panel ikonundan 
Photoshop’un, çalışma içeriğine göre belirlemiş olduğu hazır panel gruplarından da 
seçebilirsin. 

Tüm panellerde sağ üstte yer alan menü ikonunu tıkladığımızda o panelde yapılabilecek 
hemen hemen tüm seçenekleri görebiliriz. Layers Panelinde ise yeni layer oluşturma, 
kopyalama, layer’ları gruplama, silme ve görünümünü düzenleme gibi birçok özelliği buradan 
yönetebilirsin. 

 

Panelin en üstünde yer alan bölümde layer çeşidine göre filtreleme (arama) yapabiliyoruz. 
Çok fazla layer içeren çalışmalarda bu bölüme ihtiyaç duyabilirsin. Çalışmadaki piksel 
tabanlı layer’lar, Adjustment layer’lar, yazı içerenler, şekil (path) içerenler ve akıllı 
nesneleri filtreleyebilirsin. 

Hemen alttaki Blending Mode bölümünü ise layer’a farklı görünümler katmak için 
kullanıyoruz. 

Aynı zamanda herhangi bir layer’ın üstünde sağ tıkladığımızda Blending Options bölümünü 
görürüz. Burada layer’a farklı efektler ekleyebilirsin. Bevel and Emboss ile 
kabartma, Stroke ile kenar çizgisi oluşturma, Inner Shadow ile iç gölge oluşturma, Inner 
Glow ile içe doğru ışık verme, Satin ile pürüzsüz ve parlak bir yüzey oluşturma, Color 
Overlay ile renk değiştirme, Gradient Overlay ile geçişli renkler oluşturma, Pattern 
Overlay ile desen verme, Outer Glow ile dışa doğru ışık verme, Drop Shadow ile gölge 
oluşturma işlemlerini yapabilirsin. Efektlerin bazılarının yanında görünen “+” işaretine 
tıkladığında ise, aynı efektten nesneye toplamda 10 farklı değer daha ekleyebilirsin.  

Şimdi Opacity ve Fill değerlerinin ne işe yaradığına bakalım. Stroke uygulanmış bu layer’ı Alt 
tuşu ile kopyalıyorum. Üstteki layer’ın Opacity değerini %50 yapıyorum. Alttaki layer’ın da Fill 
değerini %50 yapıyorum. 

Opacity ile Fill arasındaki fark şudur: Opacity, layer’ın bütün olarak şeffaflığını değiştirir. Fill 
ise, layer’a uygulanmış tüm Layer Style efektlerini hariç tutup, sadece layer’ın şeffaflığını 
değiştirir. 

Alltaki Lock (kilit) bölümünde sırasıyla: 

 



Bu kilit sadece o layer’ın sınırları içinde işlem yapabilmeni sağlar. Yaptığın işlemler dışarı 
taşmaz. 

 

Bu kilitle boyama, doku kopyalama, silme gibi tüm piksel tabanlı işlemleri kapatmış olursun. 

 

Bu seçenek layer’ı hareket ettirmeyi veya transform işlemi yapmayı engeller. 

 

Bu kilit, Artboard veya Frame özelliğini kullandığında, dosyaya eklenen nesnelerin otomatik 
olarak gömülü gelmesini engeller yani ayrı bir imaj olarak ekler. 

 

Bu kilit ise layer’ın tüm işlemlere kapatılmasını sağlar. 

Panelin altında yer alan ikonlar ise sırayla: 

 

Zincir seçeneğiyle iki veya daha fazla sayıdaki layer’ı birbirine bağlayabilirsin. Bu sayede tüm 
bağlı layer’ları aynı anda hareket ettirebilirsin. 

 

Fx ile Blending Options bölümüne geçiş yapabilirsin. 

 

Maske ile yeni bir maske oluşturabilirsin. 

 

Adjustment Layer ile yeni bir ışık veya renk maskesi ekleyebilirsin. 

 

New group ile yeni bir grup oluşturup, istediğimiz layerları bu gruba taşıyabiliriz. Gruplama 
işlemini, önce istediğin layer’ları shift ile seçerek Komut+G ile de yapabilirsin. 

 
New Layer ile yeni ve boş bir layer oluşturursun. 

 

Çöp kutusuyla da seçili olan layer’ı silebilirsin. 

DERS 5- Dosya / Image İşlemleri 



Photoshop CC’de daha önceki versiyonlardan farklı bir arayüz kullanılıyor. Bu yeni arayüzde, 
dosya oluşturma ve dosya açma işlemleri ana sayfadan yapılabiliyor. Ama ben her ihtimale 
karşı eski versiyonlarda da geçerli olan ortak yöntemi anlatacağım. 

a. Yeni Dosya Oluşturma 

Yeni bir dosya oluşturmak için File>New (Komut+N) seçeneğini kullanıyoruz. Oluşturacağın 
dosyanın teknik özelliklerini burada belirliyorsun. Eğer çalışmanı web ortamında 
kullanacaksan ölçü birimlerini “pixel” seçip boyutunu girdikten sonra, çözünürlüğü 72 dpi 
yazarak RGB renk modunu seçeceksin. Eğer baskı yapılacak bir çalışma olacaksa, cm veya 
mm’yi seçtikten sonra boyutu girip, çözünürlüğü 300 dpi yazarak CMYK renk modunu 
işaretleyeceksin. Bu girdiğin değerlerin hepsi sonradan değiştirilebilir ancak dikkat etmen 
gereken konu dosya boyutu ve çözünürlüktür. Dosya boyutunu veya çözünürlüğü ilk açtığın 
ölçüden daha büyük bir ölçüye dönüştürmek istersen, çözünürlükte kayıplar olacaktır. 
Küçültürsen herhangi bir sorun olmaz ama dosya boyutlarını veya çözünürlüğünü sonradan 
büyütmek biraz tehlikeli bir durumdur. 

DERS 6- Kadraj / Transform 

Çalışmalarda ihtiyaç duyacağın yapısal değişiklikler olabilir. Bunlardan biri crop yani kadrajdır. 
Çalışmayı kullanacağın yere ve ölçülere bağlı olarak bir alanı çerçeve içine alıp görüntüye 
kendi yorumunu katabilirsin. 

 

Crop Tool’u seçtikten sonra üstteki alana ölçüleri giriyoruz. Girdiğin ölçünün yanına hangi 
ölçü birimini kullanıyorsan onu yazabilirsin. Piksel için “px”, santimetre için “cm” yazman 
yeterli olacaktır. Eğer bu alanları boş bırakırsan, dosyanın kendi ölçü biriminde serbest bir 
kadraj alanı belirleyebilirsin. Kadraj esnasında çerçeveni döndürebilir ve açıyı istediğin gibi 
ayarlayabilirsin. Enter tuşuna basarak da yeni kadrajını onaylayabilirsin. 

Çalışma dosyasının içindeki bir nesnenin boyutunu değiştirmek, döndürmek veya yapısal bir 
değişiklik yapmak istediğinde Edit>Free Transform (Komut+T) kısayolunu kullanabilirsin. 
Oluşan çerçevenin köşelerinden veya kenarlarından tutup büyütme ve küçültme işlemi 
yapabilirsin. Photoshop’un 2019 versiyonuyla birlikte bu işlem orantısal olarak 
gerçekleşmektedir. Daha önceki versiyonlarda ise orantıyı korumak için Shift tuşuna basman 
gerekiyordu. 2019 versiyonunda Shift tuşuna bastığında serbest moda geçiyor. Çerçeve 
içinde sağ tıkladığında transformun farklı özelliklerini göreceksin. 

Scale ile büyütüp küçültme işlemi yapabilirsin. 

Rotate ile döndürme işlemi yapılıyor. 

Scew ile herhangi bir noktayı doğrusal olarak hareket ettirirsin. 



Distort ile bir noktayı serbest olarak hareket ettirebilirsin. 

Perspective ile nesneye perspektif bir açı katabilirsin. 

Warp ile çerçevedeki her noktayı bağımsız olarak hareket ettirebilirsin. 

Rotate 180° ile 180 derece döndürebilir, 

Rotate 90° Clockwise ile 90 derece saat yönünde çevirebilirsin. 

Rotate 90° Counter Clockwise ile 90 derece saat yönünün tersine çevirebilirsin. 

Flip Horizontal ile ayna görüntüsü vererek resmi yatay olarak 180° çevirebilirsin. 

Flip Vertical ile de aynı çevirmeyi dikey olarak gerçekleştirebiliyoruz. 

Aynı zamanda çerçevenin içinde yer alan merkez noktasını değiştirerek, transform işlemini 
bu yeni merkezi baz alarak yapabilirsin.  

Transform özelliklerinin hemen hepsini klavyedeki Komut, Alt ve Shift tuşlarını farklı 
kombinasyonlarda kullanarak gerçekleştirebiliyoruz. Deneyip keşfetmeni tavsiye ederim, 
işlemlerine hız kazandıracaktır.  

DERS 7- Dekupe ve Path Oluşturma 

Genellikle arka plan değişimi veya bölgesel renk ve ışık değişiklikleri için ihtiyaç duyduğumuz 
seçili alan oluşturma işlemini farklı seçim araçlarıyla gerçekleştirebiliyoruz. Bunların arasında 
en popüler ve kullanışlı olanı pen aracıdır. Pen aracıyla hem detaylı seçimler yapabilir, hem 
de bu seçimleri kaydederek sonradan kullanabilirsin. Dekupeye başlamak için 
fotoğrafı Komut+Space tuşlarına basılı tutarak yakınlaştırıyorum. 

 

Pen aracını seçip üstteki Pen Options bölümünden Rubber Band özelliğini aktif hale 
getiriyorum. Bu sayede çizim yaparken path’in nasıl bir yol izleyeceğini görebilir ve daha 
kolay seçimler oluşturabilirim.  

 



Bu fotoğrafta birden fazla seçim yolunu aynı anda oluşturacağımız için Exclude Overlapping 
Path Areas bölümünü seçiyorum. Path çizimlerinde sürekli bu seçenek işaretli kalabilir. 

Seçime başlayacağım ilk noktaya tıklıyorum, sonra ikinci noktaya tıklıyorum. Şimdi burada bir 
kavis oluşturmam gerekiyor. Bunun için sıradaki noktayı en doğru yere koyup, mouse’a basılı 
tutup çekerek seçime kavis verebilirim. Fakat bu kavisi öyle doğru vermeliyim ki sonraki 
adımımda pen doğru yolda ilerleyebilsin. Eğer yanlış yere nokta koyar ve kavis verirsem, path 
doğru bir şekilde ilerlemez ve ikinci adımda sorunla karşılaşırım. Bu işlemin püf noktası kavis 
verirken mouse’u path yörüngesinde ilerletmektir. Diyelim ki bir noktada yanlış yaptığını 
farkettin. Bunu düzeltmek için Komut’a basıp o noktayı hareket ettirebilirsin. Eğer kavisli bir 
noktaysa Komut tuşuyla tıkladığında kavisin kılavuz çizgileri de görünecektir. Bu kılavuz 
çizgilerini de yine Komut tuşuya kontrol edebilirsin. Köşeli bir noktayı sonradan kavisli hale 
dönüştürmek içinse, Alt tuşuyla köşeli noktayı tutup herhangi bir yöne çekebilirsin. Kavis 
kılavuz çizgileri hemen ortaya çıkacaktır. Path’deki bir noktayı silmek içinse fareyle noktanın 
üstüne gelip tıklaman yeterli. Path’e yeni bir nokta eklemek için de path üzerinde nokta 
olmayan herhangi bir yere tıklıyoruz. 

Path’i devam ettirip son noktayı koyarak ilk seçimi bitiriyorum. Ardından dışına geçiyorum. 
Buradaki uzun kavisi tek parçada oluşturabilmek için, başlangıç noktasına tıklıyorum ve sonra 
bitiş noktasına tıklayıp, mouse hareketiyle doğru kavisi ayarlıyorum. Fakat bu noktadan sonra 
path istemediğim bir yöne doğru pozisyon alıyor. Bu yolu düzeltmek için Alt tuşuna basıp son 
noktaya tıklayarak üstteki kavisi kaybediyorum. İlerleyip diğer seçimimi de tamamlıyorum.  

Bu çizdiğim alanlar Path Panelinde “Work Path” olarak oluştu. Eğer bu path’i sonradan yine 
kullanacaksam, Work Path’a çift tıklayarak path’i kaydediyorum. Şimdi Komut+Enter’a 
basıyorum ve path’i seçili alan haline getiriyorum. Sonrasında Komut+J ile bu alanı ayrı bir 
layer olarak kopyalıyorum. Arka planın gözünü kapatıp açtığımda artık bu seçimin bağımsız 
bir layer haline gelmiş olduğunu görebiliyorum. 

DERS 8- Işık ve Renk Ayarları 

Bu bölümde işlenecek bir fotoğrafın öncelikli işlemi olan ışık ve renk ayarlarını anlatacağım. 
Bu işlem için genellikle Image>Adjustment menüsündeki özellikleri kullanıyoruz. 

Bu fotoğrafta modele biraz fazla ışık gelmiş. Öncelikle Image>Adjustment>Levels (Komut+L 
kısayolu) ile genel bir ışık ayarı yapalım. Levels panelinde sol taraftaki değer sadece koyu 
tonlara, ortadaki değer tüm tonlara, sağdaki değer ise sadece açık tonlara işlem yapar. Sol 
alttaki değer tüm tonların ışığını bir perde gibi açar, sağdaki değer de tüm tonları bir perde 
gibi koyulaştırır. Bu değerleri sıfırlamak için alta basıp “Cancel” butonu “Reset” butonuna 
dönüştükten sonra tıklayabilirsin. Bu kısayolu bu tipteki tüm panellerde kullanabilirsin. 

Şimdi fotoğrafın ihtiyaç duyduğu koyulaştırma işlemini yapıyorum ve onaylıyorum. Bölgesel 
olarak ışığın fazla olduğu yerlere müdahale etmek için Magic Wand ile hızlı bir seçim 
yapıyorum. Mevcut seçime yeni alanlar eklemek için shift tuşunu kullanıyorum. Modelin alın 
bölgesi, elmacıklar ve çene, diğer bölgelere göre daha önde olduğu için bu bölümler daha 
fazla ışık almış. Fazla ışık aynı zamanda omuzlar ve ellerde de var. Oraları da seçime 



ekledikten sonra yapılacak renk ve ışık ayarının geçişlerinin doğal olması için seçili alana 
“Feather” yani yumuşak geçiş değeri vermem gerekiyor. Burada ben 20 px değeri veriyorum. 
Bu değer fotoğrafın çözünürlüğüne ve tecrübeye bağlı olarak verilecek bir değerdir. Zamanla 
sende de oluşacaktır. Ardından yapacağım işlemi daha iyi görebilmek için Komut+H ile seçili 
alanı gizliyorum. 

Seçtiğim alandaki açık tonlara Image>Adjustment>Color Balance (Komut+B) ile renk 
vereceğim. Biraz kırmızı ve biraz sarı ile bu alanın ciltteki diğer renk tonlarına daha yakın 
olmasını sağlayabilirim. Ardından Levels ile biraz koyulaştırabiliriz. Sonra gizli olan bu seçimi 
kaldırmak için Komut+D yani “Deselect” işlemini yapıyorum. Yaptığım değişiklikleri 
görebilmek için History Panelinin en üstünü tıklayıp Komut+Z ile önce-sonra kıyaslamasını 
yapabilirim. 

Yapacağın ışık ve renk ayarlarını sonradan değiştirebilmek veya geri alabilmek 
için Adjustment Paneli’ni kullanabilirsin. Bu panelde ihtiyaç duyacağın tüm ışık ve renk 
ayarlarına ulaşabilirsin. Yeni eklediğin bir Adjustment, Layers panelinde görünecektir. 
Yapacağın değişikliğin sadece Adjustment’ın altındaki layer’da etkili olmasını istiyorsan, alt 
tuşu ile iki layer’ın arasına gelip tıklayabilirsin. Küçük bir ok çıktığında bu iki layer’ın birbirine 
entegre olduğunu anlayabilirsin. Artık yapacağın değişiklikler sadece bu layer’da aktif 
olacaktır. Eğer bu entegrasyonu yapmazsan, değişiklikler dosyadaki tüm layer’ları etkiler. 
İlerleyen aşamalarda da olsa verdiğin bu değerleri değiştirebilir veya tamamen kaldırabilirsin. 
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1- File / Dosya Menüsü : Temel Dosya 

işlemleri için kullanılan menüdür. Yeni dosya açma, 

var olan dosyayı açma, kaydetme, farklı kaydetme, 

yazdırma, içe ve dışa aktarma gibi işlemleri yapar. 

 

Alt menülerin sağ tarafında yer alan tuş 

kombinasyonları o menünün kısayolunu gösterir. 

Bu durum tüm menüler için geçerlidir. 

 

Ctrl+N       : Yeni sayfa aç (New)  

Ctrl+O       : Varolan dosyayı aç (Open)  

Ctrl+W  : Çalışma sayfasını kapat (Close) 

Ctrl+S       : Kaydet (Save)  

Ctrl+Shift+S : Farklı kaydet (Save As) 

Ctrl+P  : Yazdır (Print) 

Ctrl+Q  : Photoshop’tan çıkış (Exit) 

F12  : Üzerinde çalışılan görseli ilk 

açıldığındaki haline döndürür. (Revert) 

 

Place: Doküman içinde görsel açar.  

 

Import: Dış ortamdan (scanner, kamera vb.) 

görüntü aktarır. 

 

Export: Dökümanı dışa aktarır.  
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2- Edit / Düzen Menüsü: Çalışma sırasındaki komutları ileri, geri alma, yapıştırma, kesme, 

kopyalama, döndürme, perspektif ekleme, dolgu rengi verme, çerçeve ekleme gibi işlemeleri 

yapar. 

Ctrl+Z  : İşlemi sadece 1 adım geri al. (Undo) 

Ctrl+Shift+Z : İşlemi adım adım geri al (StepForward)                                                                       

Ctrl+X  : Kes (Cut)                                                 

Ctrl+C  : Kopyala  (Copy)                                       

Ctrl+V  : Yapıştır  (Paste)                                          

Ctrl+T  : Serbest Boyutlandırma (Free Transform) 

Clear: Seçili bölgeyi temizler 

Check Spelling : Yazım hatalarını denetlemeye yarar. 

Find and Replace Text: Metinler üzerinde toplu 

olarak düzenleme yapmaya yarar. 

Fill: Dolgu eklemeye yarar. 

Stroke: Çerçeve (kontur) ekler. 

Puppet Warp: Çalışma üzerinde istenen yerlere 

konulan noktalar ile görsele istenildiği gibi transform 

vermeye yarar. 

Free Transform: Serbest transform verme. 

Trasform: Görseli belli kalıplara/seçeneklere göre 

boyutlandırma yapmak için kullanılır.             

Transform seçenekleri: 

 Scale: Seçili alanı boyutlandırır. 

 Rotate: Seçili bir alanı döndürür. 

 Scew: Seçili alanı paralel kenar şeklinde 

boyutlandırır. 

 Distort: Seçili bir alanı serbest olarak 

düzenlemeye yarar.   

 Perspektive: Seçili bir alanı perspektif 

kurallarına göre boyutlandırır. 

 Warp: Seçili alanı dalgalı bir şekilde 

boyutlandırmaya / düzenlemeye yarar. 

 

Define Brush Preset: Görseli fırça olarak tanımlar. 

Define Pattern: Görseli desen olarak tanımlar. 

Define Custom Shape: Görseli şekil olarak tanımlar. 

 

Keyboard Shortcuts: Kısayolları düzenlemeye yarar. 
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3- İmage / Resim Menüsü: Bir dökümanın boyut, çözünürlük gibi yapısal özelliklerinin 

ayarlanabildiği ve Adjusment/Ayarlamalar alt menüsü ile görsel ile ilgili renk, ton vb. 

ayarlamaların yapıldığı menüdür. 

Ctrl+Alt+I   : Görsel boyutu ayarla (image size)                 

Ctrl+L   : Renk seviyesi (Level)               

Ctrl+U   : Renk/Doygunluk (Hue/Saturation) 

Ctrl+B   : Renk balans (Color Balance) 

 

Mode: Dökümanın renk moduyla ilgili alt menüdür. Bu 

menünün altında Bitmap, Grayscale, Duotone, RGB, CMYK, 

Lab Color, MultiChannel renk modları yer alır. 

Image Rotation: Resmi açılı olarak döndürür. 

Crop: Görselin istenen kısmını kesme 

Duplicate: Dökümanın kopyasını oluşturma 

Adjusment:  Seçili bir alanın veya nesnenin rengiyle ilgili 

tüm işlemler (Işık, kontrast, parlaklık, renklerin seviyeleri, 

renk tonları ve doygunluk vb.) bu menüdedir.  Adjusment 

altındaki seçenekler şunlardır: 

Brightness/Contrast:  Parlaklık ve kontrast ayarı 

Levels: Renk seviye ayarı 

Curves: Renk ton ayarı (açıklık, koyuluk ve grilik değerleri) 

Exposure: Renk ton ayarı  

Vibrance: Doygunluk ayarı 

Hue/Saturation: Parlaklık ve doygunluk 

Color Balance: Renk dengesi  

Black & White: Siyah-beyaz yapma 

Photo Filter: Hazır renk filtreleri ekleme  

Channel Mixer: Renk geçişlerini düzenleme 

Invert: Görsel renklerini ters çevirme 

Posterize: Ton yakınlığı olan renkleri aynı seviyeye getirme 

Threshold: Siyah-beyaz arası geçiş 

Gradient Map: Farklı renkler arası geçiş 

Selective Color: İstenen rengin düzenlemesi 

Shadows/Highlights: Gölge ve ışık değeri ayarlama 

HDR Toning: HDR ton ayarı 

Variations: Görsele otomatik renk tonu uygulama 

Desaturate: Doygunluğu azaltma 

Match Color: Renk karşılaştırması ile renk dengelemesi yapma 

Replace Color: Görsel üzerindeki rengi başka renk ile değiştirme                                                             

                                          Equalize: Renk balans ayarı 
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4- Layer / Katman Menüsü: Katmanlarla ilgili tüm işlemler bu menüden yapılır. Yeni katman 

açma, katmanı çoğaltma, katmanları birleştirme, katman özelliklerini ayarlama gibi işlemler 

bu menüden yapılabilir. 

Ctrl+Shift+N : Yeni katman (New Layer)                     

Ctrl+J  : Katmana kopya çıkar (Layer via copy) 

Ctrl+E  : Katman birleştir (Merge Layer) 

Duplicate Layer: Katmanın kopyasını oluşturma 

Delete Layer: Katmanı silme 

Layer Properties: Katmanlara efekt vermek için kullanılan 

menü. 

Layer Mask: Katmanlar üzerine maske oluşturma. 

Smart Objects:  

Rasterize: 

Group Layers: Katmanları gruplamayı sağlar. 

Ungroup Layers: Oluşturulmuş katman grubunu çözer. 

Hide Layers: Katmanı gizleme. 

Lock Layers: Katmanları kilitleme. 

Link Layers: Katmanları birbirine zincir ile bağlama. 

Merge Layer: Katmanları birleştirme. 

Flatten Image: Tüm katmanları tek katman olarak 

birleştirir ve kilitler. 

 

 

 

 

 

5- Type / Tip/Şekil Menüsü: Bu menü CS5’de değil CS6’da yer alan bir menüdür. Bu menü ile 

metinler üzerinde daha detaylı olarak düzenleme yapılır.  
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6- Select / Seçim Menüsü: Görsel üzerinde yapılmış seçili alanlar ile ilgili işlemler, düzenlemeler 

yapılmasını sağlayan menüdür. 

 

Ctrl+A  : Tümünü seç (All) 

Ctrl+D  : Seçimi iptal et (Deselect) 

Ctrl+Shift+R : İptal edilen seçimi tekrar yap (Reselect) 

Ctrl+Shift+I : Seçim dışındaki alanı seç (Inverse) 

Ctrl+Alt+R : Seçimi iyileştir (Refine Mask) 

 

All Layers: Tüm katmanları seçme. 

Deselect Layers: Seçilmiş katmanların seçimini iptal eder. 

Similar Layers: Benzer özelliklerdeki katmanları seçer. 

Color Range: Benzer renk tonlarının bulunduğu alanı seçer. 

Refine Edge: Yapılan seçim üzerinde iyileştirme işlemini sağlar. 

Modify: Seçim işlemine uygulanacak çerçeve, köşe 

yumuşatma, transparan yapma, seçim genişletme ve daraltma 

işlemlerini içerir. 

Transform Selection: Seçim yapılan alana transform vermeye 

yarar. 

Edit in Quick Mask Mode: Yapılan seçim işlemini Quick Mask 

moduna alır. 

Save Selection: Seçim işlemini kaydeder. 

Load Selection: Kaydedilen seçimi uygular. 
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7- Filter / Filtre Menüsü: Görsel üzerinde efekt veya artistik bir görünüm oluşturmak için 

kullanılan menüdür. 

Filtreleri öğrenmenin en güzel ve en etkili yolu deneme-

yanılmadır. Bilmeniz gereken bazı noktalar ise: 

- Eğer çalışma sayfanızda seçili bir alan varsa filtre 

sadece bu bölgeye, eğer seçili bir alan yoksa tüm katmana 

uygulanır. 

- BMP uzantılı bitmap dosyalara filtre uygulanmaz. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8- 3D Menüsü: Bu menü de CS6 da yer alır. 3D katmanlarla ilgili işlemlerin yer aldığı menüdür. 
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9- View / Görünüm Menüsü: Photoshop’ta hazırlanan çalışmaya yaklaşıp uzaklaşma, ızgara 

veya cetvelleri aktif/deaktif edebilmeyi sağlayan seçenekler ve 

görünüm ile ilgili diğer işlemlerin yer aldığı menüdür. 

Ctrl++  : Çalışma sayfasına yaklaşma (Zoom In)                                                               

Ctrl--  : Çalışma sayfasından uzaklaşma (Zoom Out)                                     

Ctrl+0  : Çalışmayı ekrana sığdırır. (Fit On Screen)                              

Ctrl+1  : Orjinal boyutunda gösterir. (Actual Pixels)                                                                                                              

Ctrl+R  : Cetveli açar / kapar (Rulers)                                            

Gamut Warning: Baskıda sorun çıkarabilecek renkleri bulur. 

Print Size: Çalışma sayfasının baskıda nasıl görüneceğini 

gösterir. 

Screen Mode: Ekran görünüm seçenekleri yer alır. 

Lock Guides: Kılavuz çizgilerini kilitler. 

Clear Guides: Kılavuz çizgilerini temizler. 

Lock Slices / Clear Slices: Slice kilitleme ve temizlemeye yarar.    
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10- Window / Pencere Menüsü: Çalışma alanınızda yer alan menü, pencere ve panellerin 

düzenlenmesini sağlayan menüdür. Alt menülerin solunda yer alan tik işareti o pencerenin 

çalışma sayfasında yer aldığını gösterir. (Örneğin Color, Layers) 

 

 

Arrange: Açık olan çalışma sayfalarının nasıl dizileceği / sıralanacağı ile 

ilgili seçenekler yer alır. 

 

Workspace: Hazır olan çalışma alanı tercihleri yer alır. Örneğin resim 

üzerinde bir çalışma yapıyorsak brush (fırça), color (renk) ve layers 

(katman) paletlerinin açık olduğu PAINTING seçeneğini veya tasarım ile 

ilgili bir çalışma yapıyorsak swatches, layers, charachters paletlerinin 

açık olduğu DESIGN çalışma alanı seçeneğini seçebiliriz. 

 

Ayrıca workspace alt menüsü altında yer alan NEW WORKSPACE 

seçeneği ile en çok kullandığımız paletleri aktif edip istediğimiz bir isim 

ile kaydedebiliriz. DELETE WORKSPACE seçeneği ile de silebiliriz. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11- Help / Yardım Menüsü: Photoshop ile ilgili yardım alabileceğiniz menüdür. 



Grafik ve Animasyon ders notları
Boyama ve Dolgu İşlemleri

Renk Seçimi
Ön/Arka plan rengini değiştirmek;

1- Hangi renk
değiştirilecek ise onun
üzerine çift tıklanır
ekrana gelen Color
Picker aracılığı ile
istenen renk seçilir.

2- Color paletinden ön/arka plan renk kutusu seçilir. İstenilen
ön/arka plan rengi renk çubuğu veya sürgüler yardımı ile elde
edilir.

3- Araç çubuğundan “Eyedropper Tool” aracı ile Grafik
üzerindeki bir noktanın rengini Foreground(ön plan) rengi, Alt
tuşu basılı olarak tıklanırsa Background(Arka plan) rengi
olarak alır.

Boyama araçları:

1. Brush(Fırça): Seçilen ön plan  rengi ile boyama yapar.
Fırçanın seçenekleri

 Fırçanın daha önceden tanımlanmış ayarlarını gösterir.

 Fırçanın uncun şekli ve kalınlığını belirlemek için kullanır. Düğmenin
üzerindeki  tıklanarak açılması sağlanan aşağıdaki pencereden değişik seçeneklere
ulaşılabilir.

 Saydamlık derecesini belirlemek için kullanılır. Sıfıra yaklaştıkça şeffaflık,
yüze yaklaştıkça matlık artar.

 Boya akışını belirler.

 Havalı fırça kapasitesini belirler.

 Renk karıştırma/boyama modları için kullanılır. Bu modlar;

Fırça paletin sağ üst köşesindeki ok
işareti tıklanarak açılacak olan menü
aracılığı ile daha değişik fırça uçlarına
ulaşılabilir.

Fırça Uçları Listesi



Grafik ve Animasyon ders notları
Boyama ve Dolgu İşlemleri

· Normal: Boyama yapılan alandaki her piksel belirtilen renk ile tam olarak doldurulur.
Doyası ile çizilen görülür.

· Dissolve: Eritme. Seçili renk ile grafik rengini rast gele yer değiştirir. Sonuçta fırça
darbelerine benzer bir görüntü oluşur.

· Behind: Geride. Şeffaflaştırılmış katmanın gerisinde boyama işlemi yapar. Katmanın
ardında çiziliyormuş gibi bir etki oluşturur.

· Clear: Üzerinden geçtiği noktaları saydamlaştırır.
· Darken: Karartma. Grafik rengi ile seçilen renk karışımından oluşan renkten daha

koyu olan piksellerde bir değişiklik olmaz.
· Lighten: Aydınlatma. Grafik rengi ile seçilen renk karışımından oluşan renkten daha

açık olan piksellerde bir değişiklik olmaz.
· Multiply: Çarpma. Seçilen renk ile temel rengi çarpar. Sonuçta daha koyu bir renk

oluşur. Fırça ile her tıklamada renk biraz daha koyulaşır. Ayrı renkli fosforlu kalemle
üst üste çizim yapılmış gibi bir etki oluşturur.

· Color Burn: Renk yakma. Grafiğe ait rengi karartır.
· Screen: Ekran. Seçilen rengin tersi ile temel rengi çarpar. Sonuçta daha açık bir renk

elde edilir. Fırça ile her tıklamada renk biraz daha açılır.
· Color Dodge: Renk kaçırma. Grafiğe ait rengi parlatır.
· Overlay: Genelde resmin koyu tonları üzerinde boyama işlemi yapar. Grafiğe ait rengi

esas alarak boyama işlemi yapar.
· Soft Light: Yumuşak aydınlık. Seçilen renk ile grafik rengini karıştırarak bu renge

göre koyuluk yada açıklık oluşturur.
· Hard Light: Koyu aydınlık. Işık parlamasına benzer bir etki oluşturur. Açık renkler

daha açılır, koyu renkler daha koyulaşır.
· Difference: Fark. Beyaz renklerle karıştırma gerçekleştirir.
· Exclusion: Difference modu ile aynı özelliğe sahiptir. Farklı olarak yumuşak efekt

kullanır.
· Saturation: Doygunluk. Grafiğe ait esas rengin parıldamasını sağlar.
· Color: Renk. Karışım sonucu oluşan rengi ve grafik renginin doygunluğa ulaşmasını

sağlar.
Yeni Fırça Ucu Oluşturmak:
Fırça olarak atanacak resim seçim araçlarının herhangi biri kullanılarak seçilir.

“Edit/Define Brush” menu komutu verilir. Ekrana gelecek new
Brush penceresinden Name kutusuna tıklanarak fırça için bir isim

girilir. Oluşturulan yeni fırça ucu “Fırça Uçları Listesi” de gözükecektir. Buradan seçilerek
istenildiği zaman kullanılabilir.

2.  Günlük hayatta kullanılan kalem gibidir. Seçilen ön plan  rengi ile
boyama yapar.  Brush aracının özellik ve kullanımıyla aynıdır. Düz boyama yapmak için shift
tuşu kullanılır.

3.  sulu boyama çalışmasına benzer bir boyama yapar. Brush’ın
kullanımıyla aynıdır.  Art History Brush aracının özellikler çubuğunda yer alan

 kutusu ile fırçanın grafik üzerindeki dağıtma biçimi belirlenir.

4. pikselleri birebir bir noktadan başka bir noktaya kopyalamak için
kullanılır. Kopyalanmak istenen alana alt tuşuna basılı iken tıklanır. Kopyalanacak yere
gidilerek alt tuşu bırakılıp tekrar tıklanır. Kopyala yapıştır da yeni bir katman oluşturulurken
Clone Stamp aracı ile kopyalamada yeni bir katman oluşturulmaz.



Grafik ve Animasyon ders notları
Boyama ve Dolgu İşlemleri

5. resim üzerinde desenle boyama yapmak için kullanılır. Boyama
yapılacak desen seçenekler çubuğundaki Pattern özelliği ile belirlenir.
Aracı seçilen alanı belirlenen desenle boyama işlemi yaparken pattern stamp tool aracı sadece
tıklanan alanı boyar.

Dolgu Araçları:

1.  Seçilen alanı ön plan rengi ile tek renk olarak doldurur. Paint Bucket
Tool aracının  özelliğine  değeri atanırsa ön plan rengi ile,  değeri
aktarılırsa şablondaki renkler ile doldurur. Anti Alias özelliği kullanılarak daha yumuşak bir
geçiş ve Opacity özelliği kullanılarak daha farklı bir etki oluşturulabilir.

2.  Bir rengin seçilen alanda giderek başka bir renge dönüşmesidir. Bu
aracı kullanırken geçiş etkisini belirlemek gerekir.

Silme:
Dolgu,  boyama ve düzenleme araçları ile yapılan değişiklikleri silmek için

 aracı kullanılır. Silgi araçları ayrıca düzenleme araçları konusunda  da
anlatılacaktır.



DERS 8- Işık ve Renk Ayarları 

Bu bölümde işlenecek bir fotoğrafın öncelikli işlemi olan ışık ve renk ayarlarını 
anlatacağım. Bu işlem için genellikle Image>Adjustment menüsündeki 
özellikleri kullanıyoruz. 

Bu fotoğrafta modele biraz fazla ışık gelmiş. Öncelikle 
Image>Adjustment>Levels (Komut+L kısayolu) ile genel bir ışık ayarı yapalım. 
Levels panelinde sol taraftaki değer sadece koyu tonlara, ortadaki değer tüm 
tonlara, sağdaki değer ise sadece açık tonlara işlem yapar. Sol alttaki değer 
tüm tonların ışığını bir perde gibi açar, sağdaki değer de tüm tonları bir perde 
gibi koyulaştırır. Bu değerleri sıfırlamak için alta basıp “Cancel” butonu “Reset” 
butonuna dönüştükten sonra tıklayabilirsin. Bu kısayolu bu tipteki tüm 
panellerde kullanabilirsin. 

Şimdi fotoğrafın ihtiyaç duyduğu koyulaştırma işlemini yapıyorum ve 
onaylıyorum. Bölgesel olarak ışığın fazla olduğu yerlere müdahale etmek için 
Magic Wand ile hızlı bir seçim yapıyorum. Mevcut seçime yeni alanlar eklemek 
için shift tuşunu kullanıyorum. Modelin alın bölgesi, elmacıklar ve çene, diğer 
bölgelere göre daha önde olduğu için bu bölümler daha fazla ışık almış. Fazla 
ışık aynı zamanda omuzlar ve ellerde de var. Oraları da seçime ekledikten 
sonra yapılacak renk ve ışık ayarının geçişlerinin doğal olması için seçili alana 
“Feather” yani yumuşak geçiş değeri vermem gerekiyor. Burada ben 20 px 
değeri veriyorum. Bu değer fotoğrafın çözünürlüğüne ve tecrübeye bağlı olarak 
verilecek bir değerdir. Zamanla sende de oluşacaktır. Ardından yapacağım 
işlemi daha iyi görebilmek için Komut+H ile seçili alanı gizliyorum. 

Seçtiğim alandaki açık tonlara Image>Adjustment>Color Balance (Komut+B) 
ile renk vereceğim. Biraz kırmızı ve biraz sarı ile bu alanın ciltteki diğer renk 
tonlarına daha yakın olmasını sağlayabilirim. Ardından Levels ile biraz 
koyulaştırabiliriz. Sonra gizli olan bu seçimi kaldırmak için Komut+D yani 
“Deselect” işlemini yapıyorum. Yaptığım değişiklikleri görebilmek için History 
Panelinin en üstünü tıklayıp Komut+Z ile önce-sonra kıyaslamasını yapabilirim. 

Yapacağın ışık ve renk ayarlarını sonradan değiştirebilmek veya geri alabilmek 
için Adjustment Paneli’ni kullanabilirsin. Bu panelde ihtiyaç duyacağın tüm 
ışık ve renk ayarlarına ulaşabilirsin. Yeni eklediğin bir Adjustment, Layers 
panelinde görünecektir. Yapacağın değişikliğin sadece Adjustment’ın altındaki 
layer’da etkili olmasını istiyorsan, alt tuşu ile iki layer’ın arasına gelip 
tıklayabilirsin. Küçük bir ok çıktığında bu iki layer’ın birbirine entegre olduğunu 
anlayabilirsin. Artık yapacağın değişiklikler sadece bu layer’da aktif olacaktır. 
Eğer bu entegrasyonu yapmazsan, değişiklikler dosyadaki tüm layer’ları 
etkiler. İlerleyen aşamalarda da olsa verdiğin bu değerleri değiştirebilir veya 
tamamen kaldırabilirsin. 



DERS 9- Photohop’ta Rötuş Teknikleri 

Rötuş (retouch, yeniden dokunuş), fotoğrafta sorunlu yerlerin düzeltilmesi 
işlemidir. Eskiden karakalemle negatif üzerinden rötuş yapılırken, bugün bu 
işlemi Photoshop’un bize sunduğu en etkin rötuş tekniği olan doku kopyalama 
yöntemiyle yapıyoruz. 

İlk olarak herhangi bir hatayı geri alabilmek için veya yapılan işlemlerin ilk ve 
son hali arasında kıyas yapabilmek için bu görüntünün bir kopyasını 
oluşturalım. Background’un üzerinde sağ tıklıyorum ve Duplicate Layer’ı 
seçiyorum. Layer ismine “Retouch” yazıyorum. 

İşlemlere başlamadan önce önemli bir uyarı yapmak isterim. Rötuş işleminin 
en doğal olanı fotoğrafa en az dokunulmuş olanıdır. Elindeki mouse’u veya 
tableti mümkün olduğu kadar cimri kullanmalısın, aksi halde fotoğrafta 
yapmacık bir görünümle karşı karşıya kalabilirsin. 

 

Şimdi Spot Healing Brush Tool’u seçip, gözümüze çarpan ufak sorunları 
gidermeye başlayalım. Fırça boyutunu gidereceğim sorunlara en yakın boyuta 
getiriyorum ve kenar keskinliğini en düşük seviyeye alıyorum ki dokuyu 
kopyalarken fırça darbeleri sert görünmesin. Bu araç, dokunduğumuz alandaki 
noktaları en yakındaki uygun dokuyla değiştirerek kaybediyor. 

 

Ardından göz altı balonlarını hafifletmek için Patch Tool ile işaretleyip bu alanı 
en yakın dokuya taşıyorum. Komut+Shift+F ile (Fade seçeneğiyle) son 
yaptığım işlemin değerini azaltıyorum. Aynı işlemi diğer göz altı için de 
yapıyorum.  

 

Şimdi Clone Stamp Tool’u seçip ciltteki rahatsız edici gölgelere müdahale 
edelim. Daha doğal sonuçlar elde edebilmek için Opacity değerini %40’a 
getiriyorum. Eğer %100 olarak kalırsa ciltte sert izler oluşacaktır. Buradaki püf 
nokta, kopyalanacak dokunun sorunlu bölgeye en yakındaki dokudan 
alınmasıdır. Modelin burnunun yan tarafında görünen gölgeyi de kaldırarak, 
daha estetik görünmesini sağlıyorum. Saç diplerindeki tüyleri de biraz 
azaltabiliriz. Şapkanın iç tarafında görünen bu saç teli beni biraz rahatsız etti. 
Onu kaldırmak için mümkün olduğu kadar küçük bir fırça ölçüsü seçip Opacity 
değerini %100 yaparak adım adım ilerlemeliyiz. Dikkat edersen dokuyu hep en 
yakından alıyorum. Çünkü hem ışık değerleri hem de desen değerlerinin 
arasında bir fark oluşmasını istemiyorum. Herhangi bir yanlış 
dokunuşta Komut+Z ile işlemi geri alıp kaldığım yerden devam edebiliyorum. 



Şimdi modelin dudaklarına biraz renk verelim. Pen Tool ile işaretleyip seçili 
alan oluşturduktan sonra, yumuşak kenar geçişleri için Feather verelim. Bu 
sefer feather değeri 3 px olsun. Verdiğin feather değerinin yumuşaklığını 
kontrol etmek için “Q” tuşu ile Quick Mask yapabilirsin. Kenar yumuşaklığı 
yeterli ise tekrar “Q” tuşuna basarak Quick Mask’ı pasif etmen gerekiyor. 
Ardından Color Balance’a girelim ve dudağa biraz renk verelim. Mesela ojenin 
rengine yakın bir renk yapabiliriz. Rengi verdikten sonra biraz daha 
koyulaştırmak için alttaki “Shadow” seçeneğini işaretleyerek verdiğimiz renkleri 
biraz daha koyu tonlarda ekleyebiliriz. Onayladıktan sonra gizli olan seçili alanı 
yine Komut+D ile kaldırıyorum. 

Şimdi şapkanın altındaki gölgeleri de kaldıralım. Bunun için de yine pen tool ile 
seçili alan oluşturuyorum. Bu sefer feather değerini daha az vermem gerekiyor 
çünkü kenarları keskin bir alan. Bu yüzden 1 pixel veriyorum. Ardından Eye 
Dropper Tool (Damlalık) aracıyla zemin rengini Renk Seçici alanına ekliyorum 
ve Edit>Fill seçeneğinde Foreground Color’ı seçip onaylıyorum. Bu 
işlemi Alt+Backspace kısayoluyla da yapabilirim. Sonra tekrar seçili alanı 
kaldırıyorum. 

Son olarak fotoğrafa biraz daha netlik eklemek için Filter>Sharpen>Unsharp 
Mask’ı seçiyorum. Burada Amount değerini yüksek tutarak netliği artırıyorum. 
Radius değerini arttırdığımda ise kontrast bir netlik elde ederim. Preview’ı 
tıklayıp önceki ve sonraki görünüme bakabilirsin. Bu fotoğraf için bu değerler 
yeterli olacaktır. Şimdi Sharpen Tool (Netleme Aracı)’nı seçiyorum ve bölgesel 
olarak daha fazla netleştirmek istediğim yerlere dokunuyorum. Detayları çok 
olan yerlere verdiğin netlik kendini daha iyi gösterecektir. 

Yaptığım tüm işlemleri kontrol etmek için Retouch layer’ının gözünü kapatıp, 
açıyorum. 

DERS 10- Ürün Montajı ve Gölgelendirme 

Bu bölümde aynı kompozisyonda yer alacak bir basketbol topu ve bir tenis 
topunun montajını ve gölgelendirmesini yapacağız. 

Basketbol topunu Elips seçim aracı ile basit bir şekilde seçmek için toptan 
biraz büyük bir yuvarlak oluşturuyorum. Bu işlemi böyle yapmamın nedeni, 
seçili bir alanın boyutlarında değişiklik yapabilmemizi sağlayan 
Select>Transform Selection özelliğini göstermek. Bu özelliği kullanarak 
oluşturduğum seçimi topun boyutlarına ayarlıyorum. Ardından Feather vererek 
kenar yumuşaklığını ayarlıyorum ve daha önce oluşturduğum dosyaya 
sürüklüyorum. Transform (Komut+T) ile ölçüsünü ve konumunu ayarlıyorum. 

Öncelikle gölge için boş bir layer oluşturuyorum ki bu gölgeyi farklı arka 
planlarda da kullanabileyim. Sonra topun genişliğinden biraz küçük, ince bir 



elips seçim oluşturuyorum ve bunu Alt+Backspace ile siyaha boyayarak seçili 
alanı kaldırıyorum ve bu layer’ı topun altına taşıyorum. Gölgenin kenarlarının 
doğal görünmesi için öncelikle Filter>Blur>Gaussian Blur filtresini açıyorum 
ve gölgeyi flulaştırıyorum. Sonra Filter>Blur>Motion Blur filtresi ile gölgenin 
sağa ve sola flulaşarak ilerlemesini sağlıyorum. Fotoğrafta kullanılan ana ışık 
kaynağı sol üst taraftan geldiği için topun sağ alt tarafı daha karanlık 
görünüyor dolayısıyla ben de gölgemi hafifçe sağa doğru konumlandırıyorum 
ve opacity değerini göz kararı azaltıyorum. Ardından bu gölgeyi Komut+J ile 
çoğaltıyorum ve Komut+T ile transform özelliklerindeki zincir ikonuna 
tıklayarak gölgeyi orantılı bir şekilde %50 küçültüyorum. Sonra bu yeni 
gölgenin opacity değerini biraz artırıyorum ve işlemi bitirdikten sonra bu iki 
layer’ı Komut+E ile birleştiriyorum. 

Şimdi topun yere yansımasını da yapalım. Bunun için top layer’ını Komut+J ile 
çoğaltıyorum ve bu layer’ı gölgenin altına taşıyorum ardından topun zeminle 
birleştiği noktaya getiriyorum. Yansımanın doğru açıda görünmesi için 
transforma girip Flip Vertical seçeneğini işaretliyorum. Doğal bir görünüm için 
yansımanın aşağı doğru giderek azalması gerekir. Bu işlem için layer’a bir 
maske ekliyorum ve Gradient Tool’u seçiyorum. Renk paletinde beyazın üstte, 
siyahın altta olduğuna emin olduktan sonra shift’e basarak (düz gidebilmek 
için) mouse’u aşağı doğru çekiyorum ve yansımama daha doğal bir görünüm 
kazandırıyorum. 

Şimdi çalışmama ekleyeceğim tenis topunu açıyorum. Daha önceden seçtiğim 
path’i Komut+Enter tuşuyla seçili alan haline getiriyorum ve Feather veriyorum. 
Bu topu da sürükleyerek çalışma dosyama atıyorum ve göz kararı ölçü ve 
konumlandırmamı yapıyorum. Burada dikkat etmen gereken önemli 
konulardan biri de, montaj yapacağın nesnelerin ışık kaynaklarının aynı veya 
birbirine yakın olması. Basketbol topunun ana ışığı sol üst köşeden geliyordu 
ama tesis topunda sağ üst köşeden geliyor. Yani bu topu ayna görüntüsü gibi 
ters çevirmemiz gerekiyor. Edit>Transform>Flip Horizontal ile bu işlemi 
yapıyorum. Sonra basketbol topunda kullandığım gölgeyi kopyalayarak tenis 
topunun altına taşıyorum ve ölçüsünü ayarlıyorum. Tenis topuna da aynı 
yansıma etkisini vermek için Komut+J ile çoğaltıyorum ve aynı işlemleri 
uyguluyorum. Nesnelere gerçeğe yakın gölgeler veya yansımalar verebilmek 
için, çevrendeki eşyaların gölgelerini veya yansımalarını incelemeni tavsiye 
ederim. 

Son olarak fotoğrafa daha doğal bir görünüm kazandırmak için arkada yer alan 
basketbol topuna Gaussian Blur uyguluyorum ve fotoğrafa derinlik hissi 
veriyorum. 

DERS 11- Pratik Bilgiler ve Photoshop Kısayolları 



1- Piksel tabanlı araçlarda (fırça, silgi, klonlama aracı gibi) iki nokta arasında 
düz bir yol oluşturmak istediğinde shift’e basılı tutup iki noktayı tıklaman yeterli 
olacaktır. 

2- Dodge Tool (Soldurma Aracını) “alt” tuşu ile kullandığında Burn Tool 
(Yakma Aracı) etkisi verecektir. Aynı şekilde Burn Tool’u da alt tuşuyla 
kullandığında Dodge Tool etkisi verir. 

3- Path oluştururken son noktada ucunu açık bıraksan da seçimi otomatik 
olarak tamamlar. Aynı zamanda bir path oluştururken diğerine geçebilir ve onu 
bitirdikten sonra kaldığın yerden devam edebilirsin. 

4- Son verdiğin ışık veya renk değerlerinin aynısını tekrar uygulamak için “alt” 
tuşuna basarak o menüye tekrar girmen yeterli olacaktır. 

5- Son yaptığın Transform işlemini ise Komut+Shift+T kısayoluyla yeniden 
uygulayabilirsin. 

6- Move Tool seçiliyken, Alt+Shift tuşlarını ve harfleri kullanarak (Multiply (M), 
Overlay (O) gibi) blending modlar arasında geçiş yapabilirsin. Bu işlemi fırça 
veya diğer araçlar seçiliyken yaparsan seçili aracın modlarını değiştirmiş 
olursun. 

7- Belli bir alana Alt+Backspace ile Foreground Color (ön plan rengi), 
Komut+Backspace ile Background Color (arka plan rengi) verebilirsin. 

8- Seçili alanları Select>Save Selection seçeneğiyle Alpha kanalı olarak 
kaydedebilirsin. Bu kayıtlı seçimi birazdan kullanacağız. 

9- Bir aracın Opacity ve Flow değerlerini kolayca değiştirmek için klavyedeki 
rakamları kullanabilirsin. 1’e bastığında %10, 2’ye bastığında %20 olacaktır. 
Shift ile kullandığında ise Flow değerini değiştirirsin. Bu işlemi Move Tool 
seçilliyken yaparsan layer’ın opacity ve fill değerlerini değiştirirsin. 

10- Kendine özgü bir fırça oluşturmak istersen önce bir seçili alana ihtiyacın 
olacak. Biraz önce kaydettiğimiz seçili alanı Select>Load Selection ile geri 
çağıralım. Ardından Edit>Define Brush Preset ile bu seçili alanı fırçaya 
dönüştürebilirsin. Brush Tool’u seçip, belirlediğin bir renkle kendi özel fırçanı 
deneyebilirsin.  

11- Yeni bir pattern (desen) oluşturmak içinse, dikdörtgen bir seçili alan 
işaretleyip Edit>Define Pattern ile bunu kaydediyorum. Pattern Stamp Tool ile 
kütüphaneden bu yeni deseni seçtikten sonra çalışmama uygulayabilirim. 



12- Kayıtlı bir shape (şekil) oluşturmak için, bir path çiziyoruz. 
Sonra Edit>Define Custom Shape ile bu şekli kaydediyoruz. Sonra Custom 
Shape Tool ile kütüphanedeki bu şekli seçip çalışmamda kullanabilirim. 

 


